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Packages and .NET Assemblies Best Practices for CA Plex.

1. Introduction

This document is intended to serve as a practical guide to the use of the C# in a CA Plex
development organization. It contains basic explanations of the concepts behind C#/ .NET
development, and provides guidance on usable mechanisms to implement different practices. It is
not intended to be a set of standards, but can be used as guidance for an organization to
incorporate .NET packaging into their CA Plex development standards.

This document was created in collaboration between ADC Austin and CA reference customers,
and represents practices that are in production use. In the case where there are alternatives
present or the CA Plex manual is unclear, recommendations in bold underline.

2. Use of assemblies and modules when creating code libraries

The following diagram shows the basic structure of assemblies, packages (namespaces), and
classes as they related to Plex model. For more detailed information, please consult the Plex help
topic Chapter 18 Packaging and deploying applications.
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CA Plex allows you to create 2 types of code libraries:

i Assembly — These are the building blocks of the .NET framework and contain
manifest data about its contents. Assemblies can be made up of packages or other
code libraries.

ii. Module — Usually are contained within an assembly, Modules do not contain any
manifest data as that is stored in the assembly.
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Modules are used for the following situations:

I Multi language assembly - If the assembly contains source files with different
languages, they have to be split out into different modules within the assembly.

ii. Small download footprint - If the assembly is downloaded at runtime to an
HTTP site, it is recommended that the code is divided up into the code that will be
required at login and accessing the application, and then into logical areas of
functionality. This makes the download much faster as code is only downloaded
when it is needed.

iii. Shared code. — If you have code that is shared by multiple assemblies you can
place those functions in a module and attach it to multiple assemblies. The
literature suggests care is taken when using this approach as any changes made to
that code will mean that the entire assembly will have to be created and shipped.
Therefore it is recommended that shared code be placed in its own assembly.

Given that only C# code is managed in .NET (and currently C# code is only created on the server
on PLEX and not downloaded to the client), the use of modules is not recommended.

From the Plex manual note the following recommendation. Although default code libraries
should be used in certain circumstances for unit testing, they should not be used for production
implementation due the problems with maintainability.

Plex C# functions can be built outside of the Code Library modeling concept, using the
Default Package and Code Library settings in the Generate and Build options. However,
as a best practice for .NET application deployment, it is recommended that Plex
generated C# functions be arranged by Package and Code Library. As with Java, the
Package objects define the namespace boundaries into which the Function classes are
defined. The Code Library object is the main compilation block for a Plex .NET
application; and to allow maximum flexibility, can be created as either a module or an
assembly.

Another reason for the recommendation to package all functions is cross-model references —
code will not be generated properly if defaulting techniques are used. All functions should be
assigned to an explicit package. It is recommended that the CA Package Tool be utilized for
package creation.

3. Creating and using assemblies

While having many assemblies has advantages in terms of maintenance and distribution, there
are tradeoffs with the performance of the application. The more assemblies you have the less
efficient your application will be. This is because when the application runs, it will open all the
assemblies in the assembly list (note that the CA Plex manual is unclear on this topic, but this
has been determined to be the case with the current Plex version). Therefore it is recommended
that fewer assemblies are used. In most cases this does not mean that all functions should be
put in a single assembly, as this would make maintenance difficult.

As part of creating this document, interviews were conducted with a large C#/PLEX developers,
including a software house who has been using C# for 3 years. Their application has thousands
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of Plex functions, but they have less than 10 assemblies. The key is having enough assemblies to
make management straightforward while achieving acceptable performance at run time.

Performance can be improved at runtime by giving consideration to the order of your assemblies
in the assembly list. An assembly list works much like a library list — at run time the application
will look in each assembly, starting at the beginning of the list, until it finds the first instance of
the function in needs.

Therefore when packaging your application it is recommended that consideration is given to the
frequency that functions are called. Functions that are called frequently should be packaged
together and the resulting assembly should be placed first or high in the list. Rarely used
functions should also be packaged together and the assembly should be placed last in the list.
The packages in the middle should be designed around function areas since it is more efficient
for a function to call another function within the same assembly.

Function A Function A Functicn AA1
Function XY Z1
Funclion £ Function £2 Function £21

4. Considerations when packaging your model

Taking all the above into consideration and knowledge of the application, the list of assemblies
would look something like this, with our recommendation being somewhere between 3-10
assemblies.

Core functions called frequently (Date/Common routines, Reads to common tables)
Subsystem A

Subsystem B

Subsystem Z

Core functions called infrequently (updates to common tables)

There are several techniques for adding CA Plex functions to packages. It is recommended that an
approach be taken that is easy to implement from a standards point of view, but that is also efficient.
This is most commonly done by placing entire entities into packages, and to create a separate
package or packages for unscoped functions (or scope to entities). This works well in most cases for
dividing models into subsystems without burdening the developer. In some cases that may lead to
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less efficient assemblies (perhaps some entities are read only in most cases), so depending on the
performance packaging structure may be more complex.

This must be used with care. For example, you may choose to add read functions to one package and
write functions to another. It should be noted that this should only be used in rare circumstance, if
there are extreme performance concerns. In almost all circumstances this is not recommended,
the performance gains are slight compared to the significant extra overhead of modeling
packages in this manner.

It is recommended that a function be placed in only one package/namespace. Assemblies can
contain more than one package, and assemblies can contain assemblies. This is not important from a
performance standpoint (the number and structure of the final assembly list is the key), but may be
helpful from an application understandability point of view. Regarding the use of stub functions
(function call definitions in one model where the called function resides in another, unreferenced
model), it is important to understand that stub packages that match the package in the called model
must be created.

It is recommend that packages be used to model the overall application structure, and not be
used as a version control technique (i.e. packaging a “patch” into a special package /
assembly). Packaging in the version control technique leads to difficulties in building the
application, and we believe will lead to errors and application problems. We did not interview any
C# development shop using packages / assemblies in a version control manner, and were strongly
advised against it.

On package and assembly names — it is recommended to avoid embedded spaces and special
characters. Although .NET has one set of rules for naming that includes some special characters, we
have found that other 3" party applications and other languages like Java have more restrictive
naming requirements so this is the safest approach.

5. Software required on the build server

When setting up a server to do the builds, you will need the following software installed.

. Cruise Control — A tool for managing automated builds on the server. Download from
http://sourceforge.net/projects/ccnet/files/
Select CruiseControl.NET-1.x.x-SPX-Setup.exe

ii. Microsoft. NET Framework Version 2.0 and 3.5 — You can download from:
http://www.microsoft.com/downloads/details.aspx?FamilylD=0856 EACB-4362-4B0D-
8EDD-AAB15C5E04F5&displaylang=en
Or if you install CA PLEX v6.1 on the server there is an option to install the .net
framework.

iii. Microsoft. NET Framework Version 2.0 Software Development Kit (SDK) - You can
download from:
http://www.microsoft.com/downloads/details.aspx?FamilylD=fe6f2099-b7b4-4f47-a244-
c96d69c35dec&displaylang=en

Prepared by ADC Austin. Page 6



http://sourceforge.net/projects/ccnet/files/
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856EACB-4362-4B0D-8EDD-AAB15C5E04F5&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=fe6f2099-b7b4-4f47-a244-c96d69c35dec&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=fe6f2099-b7b4-4f47-a244-c96d69c35dec&displaylang=en

Packages and .NET Assemblies Best Practices for CA Plex.

iv. Subversion — This is the repository. Download from http://www.visualsvn.com/server/

V. Tortoise — A good front end Ul for managing and working with Subversion. Download
from http://tortoisesvn.net/downloads

Vi, NANT — Allows you to write scripts to manage the automated build process. Download
from http://sourceforge.net/projects/nant/

Vii. I1S — Microsoft’s internet server. This is available from the XP Professional disc. This
link tells you how to install 11S.
http://www.webwizguide.com/kb/asp tutorials/installing iis winXP pro.asp

6. Modelling C# Code Libraries in Plex

The next section shows the modeling of the C#/.NET application in Plex. We are using the supplied
CA “SalesSystem” model typically located in the following directory:

C:\Users\Public\Documents\CA\Plex\6.1\Samples\Dot NET Support and Code Libraries
Two types of CA Plex objects must be modeled, Code Libraries and Packages.
Code Libraries

There are two code libraries, type Assembly. Refer to the screen shot for an example of the triples

Model Editor - Code Library: Order... E][E|E|
IE |complises PKG j |Dldel
|Eode Library j |<AII) ﬂ Package

Company hare C4
copyright information | Copurightinformation
major version 1
mifar wersion ]
trademark. information| Tradernarklnformation
product Productinformation
MET type Azzembly
file name Order
impl name Order
build rumber 1
Tevision number ]
language CH
Support Cconmprizes Sypstem
Company hare Ca
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Object Browser

¥ ﬂ | Code Library j

% B R0 D ET

m
=
o

i3
2

== Code Library Content

=3 Order
=27 Package Content

Note that some labels defined by the triples should have descriptive information entered into the label
name value

Details for Label: CopyrightInformation

Mame | Informationl Securityl Mamrative Literal

Walue:
Copyright C4, 2006

I~ Local ovenide

0K I Cancel Apply Help
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Packages (Name Spaces)

There are two packages in the SalesSystem model, and one (PDate) as a library model. Functions
are set up directly in the package. For large model, it is recommended to scope entities to the
package for ease of maintenance.

Object Browser

I" ;I IF'au:kage ;I
a8 R k|lowala
ﬁ' Order

(M g0 TE /PO ate

Model Editor - Package: Order,...

IEIn:Ier Icuntains F|;| II]rder.DetaiI_UpdatE
IFackage LI I{Alb ;I Function |
Order containz | Order Detail BySurogate Mext #

Order.Detail Fetch. BlockFetck
Order.Detail Fetch. CheckRow
Order. Detail Fetch. SingleF etct
Order.Detail. Update. Checked|
Order.Detail Update. D eleteRo
Order.Detail. Update. InsertF oy
-Order. Detail Update. pdateR
Drder.Header.Fetch. BlockFete
Order Header Fetch. CheckRo
Order Header Fetch. SingleF et
Order. Header. Fetch, Stateless|
Order.Header.Update. Checke

Mrdar Hazdar | lrdzbka MNalataE

Prepared by ADC Austin. Page 9



Packages and .NET Assemblies Best Practices for CA Plex.

7. Setting up the build server and installing Cruise Control

I. Configure a website on 11S for the CruiseControl.Net Dashbboard.
Go to control panel and in ‘Classics View’ select Administrative Tools. Open Internet
Information Services and find the Default Website in the tree.

“&/Internet Information Services

File  Action  Wew Help
|| 2 2
|| internet Information Se ; Computer |L0cal Wersion Skat
=I &) SC-TRAINING (local computer) | &)< 7p ATNING (local computer) Yes IS WS, 1
=-{_1 web Sites
-y Default Web Site
+- 5 115Heln
+-_g Printers
+ D bin
+- [ cotray
+-] doc
+-] images
+-[_] javascript
+-{_] Packages
+-[ templates
+-] wsl

+-i% Default SMTP Virtual Server

Select the Default Web Site. Right click and select Properties. Go to the Home
Directory Tab. The local path will be C:\inetpub\wwwroot. Change the Local Path by
prompting to the Cruise Control Dashboard. The default loacation is:

C:\Program Files\CruiseControl. NET\Webdashboard. Press OK.

Default Web Site Properties EW@

Directony Security HTTF Headers Cugtom Errors ASP.MNET
Web Site ISAF Filters Home Directary Documents

‘when connecting to this resource, the content should come from:

() directary lncated on thiz computer

() &4 share lozated on another computer
() & redirection to a URL

Local Path: C:A\Program Files\CruiseControl NET web Browse. .
[ Seript source access Log visits

Bead Index this resource

[ drite

[ Diirectary browesing
Application Settings

Application name: Default Application Remove
Starting point: <Default ‘Web Siter
Configuratian. ..
Execute Permissions; Scripts only hd
Application Pratection: | Medium [Pooled) s Unlaad
I u] l [ Cancel ] Help
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Open Internet Explorer and type: http://localhost. The Cruise Control Dashboard will

display

2l CruiseControLNET - Microsoft Internet Explorer

Elle Edit View Favorites Toals Help

O Back -

4 2

o/

Address ’e_'] hktpefflocalhost MiewF armPepart, asm:

=7 JCruiseControl.NET

CONTINUOUS INTEGRATION SERVER

Farm Report
Download CCTray

Servers
local

Server Project Name

local  SalesSystern - Build

") Search 5 7 Favorites &4

Last Build Status  Last Build Time Next Build Time

Success 2009-07-08 14:14:10 2009-07-08 14:14:17

Last Build Label CCNet Status Activity Messages

Rev-unknown

Running

Sleeping

Documentation

Refresh status

Admin

local SalesSystern - Clean

Success 2009-07-08 14:14:05 2009-07-08 14:14:16

Rev-unknown

Running

Sleeping

local

SalesSystermn - Get |atest version

Success 2009-07-08 14:14:02 Z009-07-08 14:15:03

Rev-unknown

Running

Slesping

ThoughtWorks:

W 1 aralintraner

Note: In VisualSVN server properties, checkbox “Use secure connection (https://)” has

to be unchecked in order to be reached by Cruise Control. NET

EE U VisualSYN Server Properties @

M| 2 =

B WisualSWH Server
+ @ Repositaries
D Users
[ Groups

General | Metwork | Certificate || Authentication

Server name:

[Juse secure connection fhtkps: i)

Server Binding
() Al IP addresses

() These IP addresses:

Server pork:

a0s0n w

oK ] [ Cancel

NEE|

Opens the properties dialog box For the current selection,

VISUALSUNSERVER

ide Feedback

Install CCTray

a. Click on Download CCTray link on the left panel of CC Dashboard.
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b. Save the file.

c. Execute the file saved and follow the wizard instructions.
d. Open the CCTray already installed
e
f

Select File - Settings on the top menu
Click on Build Projects tab and click on Add buton

€€, CruiseControl.NET Tray Settings

General |} B EAudio lcons || =10 | Speech

|Jze thig gection to define the projects to monitor,

Build Server Trangport Project Add...

[E] check / uncheck all

[ Ok ] [ Cancel ]

g. Click on Add Server button
h. Select the option “Connect directly using .NET remoting”
I. Leave the default value (localhost) or type it

€€ Build Server

CCTray can monitor build gervers in different waps. Select how pou want to monitor the server,
then enter the required information.

() Viathe CruiseControl. NE T dashboard

Thiz is the prefered way of monitaring build statuz. In the box below, enter the http address
of the dashboard home directary inthe box below, e.g. httpe//build-server/cenet. The
dashboard must be version 1.7 or later.

(%) Connect directly using .MET remoting

CCTray will connect directly to the build server using MET Remating. Thiz iz how
CruizeControl HET 1.0 worked, but it often forces you to install a new wersion of CCTray
when the server is upgraded.

In the box below, enter the name of the build server to monitar.  IF you have configured wour
build server to run on a port other than the default of 21234, pou can follow the name of the
build server with :port.

localhost

() Supply a custom HTTP URL

Usze thiz option ta monitor a non-CruiseContral MET build server [e.g. CruiseCantral far
Jawa). CCTray will perform an HTTF GET on thiz URL, and expect to retieve an *ML file
az descrbed at hitp: //confluence. public. thoughtwarks. arg/dizplap/Cl /.

[ QK ]’ Cancel ]

j. Click OK
k. Projects should be displayed in the right panel
I. Select the project to be added to CCTray and click on OK button
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The lizt an the left shows the build servers that CCTray curently knows about. Select a build zerver, then zelect
one of more projects o add, [Projects which are already being monitor will not show in the Projects list.]

If pou want to add a new build zerver, click Add Server.

Build Servers Availlable Projects

Add Serwver

I 0K ][ Cancel l

m. Click on OK button
n. Project selected will be displayed in CCTray
iii. Folders Structure
a. C:\CC.Net\SalesSystem - Root directory of the project. Here is the
SalesSystem.Build file

b. C:\CC.Net\SalesSystem\Actifacs > Folder that keeps CC log files

buildlogs .
File Edit ‘iew Faworites Tools Help :;'
G Back ~ > lﬁ Pl ) search H__" Folders '

Address |E| CHCC. MekSalesSystemiactifacs) Integration Cleanibuildlogs v| Go
Faolders X Mame Size  Type
[=] g Local Disk () ~ @ log200907081 3537 38Lbuild. Rev-unknowan, sl FKE  #ML Document
[T 1a56F76c469e64cBa6F250 B E log200907031 341 27Lbuild. Rev-unknown, xml 3KE  #ML Document
|05 38ec4febas 39942651 Q lag200907031 341 32Lbuild. Rev-unknown, xml 3KE  ¥ML Document
= |25 < Met Q log200907081 35057Lbuild. Rev-unknown, xml 3KE XML Document
[ MyProject Q logZ200907051 35059 build, Rev-unknovn, xml 3KEB  #ML Document
= [ SalesSystem Q log200307051 351 05Lbuild, Rev-urknowan, xrnl 3KB  #ML Document
= T3 Actifacs Q log200907081 351 36Lbuild, Rev-unknovwn, xml FKE  #ML Document
= [ Integration @ log200907081 35228Lbuild. Rev-unknowan, xrml 3KE %ML Document
B [ Clean @ log200907051 405 30Lbuild . Reev-unknowan, sl FKE  #ML Document
[} E log200907081 40534 Lbuild, Rev-unknown, xml AKE  #ML Document
= 5 Compile Q lag200907031 405 35Lbuild. Rev-unknown, xml 3KE  ¥ML Document
(£ buildlags Q log200307081 40536Lbuild. Rev-unknown, xml 3KE XML Document
= 5 GetLastestiersion Q log200907081 40537 Lbuild. Rev-unknown, xml 3KE XML Document
1) buildiags Q log200907081 405 38Lbuild, Rev-unknown, xml 3KE  #ML Document
[ Deploy Q log200907051 406 35Lbuild, Rev-unknoven, xml 3KE  ®ML Document
B [ workingDirectory @ log200907051 41405Lbuild. Rev-unknowan, sl FKE  ®ML Document
(=l i) Integration @ log200907051512 1 3Lbuild. Rev-unknowan, xrl 3KE %ML Document
3 svm QIogZDDQD?DBl&DSIlLbuiId.Rev—ID.me IKE  HML Document
= 5 Gen (2] log200907081 61023Lbuild. Rev-11,xm KB WML Document
[ svm B @IDQZDDQD?DQDBD?4DLbuiId.Rev-ll.xml 3KE XML Document
I Bid
B g Sre
[ .svn
15 obj
%) Order
&] Swskem
e Wisual studio 2005 Clients
|5 Documents and Settings v < >
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c. C:\CC.Net\SalesSystem\Deploy = Folder that keeps all the .dll files generated.
This path is defined in the SalesSystem.build file

File Edit Wiew Favorites Tools Help :'

GBack M > | lﬁ /..-\JSearch ‘H-_“ Folders '

Address |E| CHYCC . Met) SalesSystem|DeployiGeniBld v | Go
Folders x ame Size  Twpe Drake Maodifi
= [ Actifacs ~ | [Chorder File Flder 749/2009 81
= [ Inkegration ~ [E)5upport File Folder 719/2009 g1
= I Clean |’_5] SalesSystem.dll 140kE  Application Extension  7/3/2002 &1
[ buildlogs
= ) Compile
I buildlogs
= [C5) GetLastestyersion
[T buildioas
= [5) Deploy
= 155 Gen
=l
1) order

I3 Support
= |5 workingDireckory
=1 ki) Integration
£ .svn
= ki Gen
I3 .svn
i Bld
B g Src
[ .5vn
[ obi 0
g Crder
g System
%) Wisual Studio 2005 Clients
|5 Documents and Setkings
15 Inetpub
125 Inskalls w| €

P

d. C:\CC.Net\SalesSystem\WorkingDirectory = Folder used to keep the latest
version of the files. This path is defined in the SalesSystem.build file
9=]e3

File Edit View Favorites Tools  Help :’

J
eBack > lﬂ'f /..-\JSearch ‘H__" Falders '

Address ‘ﬁl CHCC ek SalesSystemiWorkingDirectory Integrationt Gen v| Go
Folders X Mame Size | Type Date Mod &

B () Compile ~ = File Folder 7i8j2009 «

3 buildiogs ~ lgnEd File Folder 7i8{2009 -

=l () Getlastestversion s File Folder 782009 ¢

£ buidiogs &) petaild. crp KB CPPFie 7/5/2009 ;

2 ) Deploy 5 DetaiEd.H 18KE HFle 7ig2009 ;

2 & Gen 5 DetailEdit RC 49KE RO File 7j8{2009 :

= ) Bd B HeaderDelete, CPP 36 KB CPPFile 7ief2009

£ Order &) HeaderDelote.H KB HFle 7/5/2009 ;

15 Suppart: @HeaderDelete‘RC I6KE RCFile Figiz009

= El ‘WarkingDireckory g HeaderGrid. CPP 45 KB CPP File Figiz009

1= ) Integration B HeaderGrid.H 13KEB HFile Figi2009

&' Svn @HeaderGrld.RC 20KE RCFile 7i8f2009

= g E] HeaderInsert. CPP 41KE (CPP File 71812009

=) .svn B HeaderInsert.H 8KE HFile FiBl2009 :

&| Ed @Header[nsert.RC 15KE RCFile 7182009

=] ﬁ Src B HeaderUpdate, CPP 43 KB CPP File 7i8f2009

I svn & HeaderUpdate.H 9KE HFile 7i8j2009

& obj @HeaderUpdate.RC 19KBE RCFile FiBi2009

% Order @ORDER_DETAIL_B\"SURROGF\‘.. 1KB WIW File 782009

% System @ORDER_DETAIL_FETCH.VIW 1KE WIW File 782009

ﬁ Wisual Studio 2005 Clients @ORDER_DETAIL_TAELE‘tb\ 2KE TEL File Figfz009

El Documents and Settings @ORDER_DETAIL_LIPDATEV\W 1KE WIW File FiBi2009

1) Inetpub @ORDER_HEF\DER_FETCH.WW 1KB WIW File 782009

E| Inskalls = @ORDER_HEF\DER_TABLE.HJ\ ZKE TELFile Figfz009
El nant @ORDER_HEADER_UPDATE.VM 1KE WIW File Fi8iz009 1 —

[ Pragram Files 5] SALESSURROGATESYSTEM_F... LKE WIW Fils 752009 ;
h Repasitories @SALESSURROGF\TESYSTEMJ—‘... 2KB TBLFile 782009 .
L5 WINDIOWS N PR RO
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iv. ccnet.config file. It’s located in C:\Program Files\CruiseControl.NET\server\ folder and
contains the definitions of the projects that will be displayed in the Cruise Control
Dashboard. The most important tag are the follows:

a. <project name=""SalesSystem - Get latest version'">. Obtains the latest version
of the files committed in repository.
i. <trunkUrl>http://sc-
training.eimsdirectl.local:8080/svn/SalesSystem/trunk</trunkUrl> is the
path where the source code has been committed.

ii. <username>&svnusername;</username> is the valid user to log into the
repository.

iii. <password>&svnpassword;</password> is the valid user to log into the
repository.

iv. <triggers>
<intervalTrigger buildCondition="1fModificationExists" />
</triggers>.

Trigger blocks allow you to specify when CruiseControl.NET will start a new
integration cycle.

<intervalTrigger> is used to specify that an integration should be run
periodically.

IfModificationExists, means that SalesSystem - Get latest version project
will only be triggered if modifications have been detected.

b. <project name=""SalesSystem - Clean"'>. Deletes the folder
C:\CC.Net\SalesSystem\Deploy\Gen\BId
I. <triggers>
<projectTrigger project="SalesSystem - Get latest version™ />
</triggers>.

<projectTrigger> is used to trigger a build when the specified dependent
project has completed its build; so, in this case, SalesSystem — Clean
project will start after SalesSystem - Get latest version has completed its
build.

ii. <tasks>.
<nant>
&nant.exe;
<buildArgs>-
D:client.dir=&deployDirectoryBase;\Integration\SalesSystem\</buildArgs
>
<buildFile>C:\CC.Net\SalesSystem\SalesSystem.build</buildFile>
<targetList>
<target>SalesSystem.Clean</target>
</targetList>
</nant>
</tasks>

<task> blocks are the action elements of CruiseControl.Net. They're the
elements that do things, like executing a program, etc
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<buildFile> is the name of the build file to run.
<buildArgs> are the arguments to pass through to NAnt
<targetList> is a list of targets to be called.

c. <project name=""SalesSystem - Build"">. Compiles the project

<triggers>
<projectTrigger project="SalesSystem - Clean" />
</triggers>
<project Trigger> is used to trigger a build when the specified dependent
project has completed its build; so, in this case, SalesSystem — Build
project will start after SalesSystem - Clean has completed its build.

ii. <tasks>

<pant>
&nant.exe;
<buildArgs>-D:server.publishdir=&deployDirectoryBase;\Integration\ -
D:server.configuration=Integration</buildArgs>
<buildFile>C:\CC.Net\SalesSystem\SalesSystem.build</buildFile>
<targetList>
<target>SalesSystem.Build</target>
<target>Order.Build</target>
<target>Support.Build</target>
</targetList>
</nant>
<[tasks>
<task> blocks are the action elements of CruiseControl.Net. They're the
elements that do things, like executing a program, etc
<buildFile> is the name of the build file to run.
<buildArgs> are the arguments to pass through to NAnt
<targetList> is a list of targets to be called.
<target>. In this case we have three targets; they’re in charge of launch the
build of SalesSystem.csproj, Order.csproj and Support.csproj respectively.
If more projects have to be build more <target> tags have to be added.
Also, targets have to be defined in the SalesSystem.build files described
below

v. SalesSystem.build file. It’s located in C:\CC.Net\SalesSystem folder and it contains
the target that can be executed by NAnt and CC. The most important tag are the

follows:

a. Properties:

<property name="root" value="${project::get-base-directory()}" />. In
this case C:\CC.Net\SalesSystem is the root folder.

. <property name="msbuild.exe"

value="C:\WINDOWS\Microsoft. NET\Framework\v2.0.50727\MSBuild.
exe" overwrite="false"/>. File that will be user to build the projects.

iii. <property name="server.configuration" value="obj" overwrite="false"/>.

Folder where configuration files will be saved
<property name="deploy.dir" value="${root}\Deploy\Gen\Bld\"
overwrite="false"/>. Folder where projects compiled will be saved

Prepared by ADC Austin.
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b. Targets:
I. <target name="'SalesSystem.Clean"">
<echo message="${deploy.dir}"/>

<delete dir="${deploy.dir}" failonerror="false" /> <!--Deletes folder
C:\CC.Net\SalesSystem\Deploy\Gen\BId -->

<mkdir dir="${deploy.dir}"/> <!--Creates folder
C:\CC.Net\SalesSystem\Deploy\Gen\BId -->
</target>

ii. <target name="'SalesSystem.Build"">
<exec program="${msbuild.exe}"
workingdir="${root}\WorkingDirectory\Integration\Gen\Src"
failonerror="true">
<arg
value="${root}\WorkingDirectory\Integration\Gen\Src\SalesSystem.csproj
">
<arg line="/t:Build /p:Configuration=${server.configuration}
/p:OutputPath=${deploy.dir}\SalesSystem /verbosity:quiet"/>
</exec>
<[target>
= SalesSystem.csproj. This project, generated by PLEX, has two
properties that have to be changed in order to obtain the source
code from the right place and to save the result .dll file in the
desired place; that properties are:
a. <SrcDir>C:\CC.Net\SalesSystem\WorkingDirectory\integ
ration\Gen\Src</SrcDir>
b. <BIdDir>C:\CC.Net\SalesSystem\Deploy\Gen\Bld<
/BldDir>
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iii. <target name=""Order.Build">
<exec program="${msbuild.exe}"
workingdir="${root}\WorkingDirectory\Integration\Gen\Src"
failonerror="true">
<arg
value="${root}\WorkingDirectory\Integration\Gen\Src\Order.cspr
0j"/>
<arg line="/t:Build
/p:Configuration=${server.configuration}
/p:OutputPath=${deploy.dir}\Order /verbosity:quiet"/>
</exec>
<[target>
= Order.csproj. This project, has been generated using Code
Library Wizard from PLEX; in this project we have to add a
reference in order to be reached by NAnt and avoid compilation
problems; the line that have to be added in the Order.csproj file
is:

a. <Reference
Include="$(PlexInstallDirectory)\Ob.NET\Release\Plex.O
bRun.dll" />

This line must be placed in the <ltemGroup> block

<IltemGroup>

<Reference Include="$(PlexRuntime)">
<SpecificVersion>False</SpecificVersion>
<Private>False</Private>

</Reference>

<Reference Include="System" />

<Reference Include="System.Data" />

<Reference Include="System.Xml" />

<Reference

Include="$(PlexInstallDirectory)\Ob.NET\Release\Plex.ObRu

n.di" />

</ltemGroup>
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iv. <target name=""Support.Build">
<exec program="${msbuild.exe}"
workingdir="${root\WorkingDirectory\Integration\Gen\Src"
failonerror="true">
<arg
value="${root}\WorkingDirectory\Integration\Gen\Src\Support.cs
proj"/>
<arg line="/t:Build
/p:Configuration=${server.configuration}
/p:OutputPath=${deploy.dir}\Support /verbosity:quiet"/>
</exec>
<[target>
= Support.csproj. This project, has been generated using Code
Library Wizard from PLEX; in this project we have to add a
reference in order to be reached by NAnt and avoid compilation
problems; the line that have to be added in the Order.csproj file
is:

a. <Reference
Include="$(PlexInstallDirectory)\Ob.NET\Release\Plex.O
bRun.dll" />

This line must be placed in the <ltemGroup> block

<IltemGroup>

<Reference Include="$(PlexRuntime)">
<SpecificVersion>False</SpecificVersion>
<Private>False</Private>

</Reference>

<Reference Include="System" />

<Reference Include="System.Data" />

<Reference Include="System.Xml" />

<Reference

Include="$(PlexInstallDirectory)\Ob.NET\Release\Plex.ObRu

n.di" />

</ltemGroup>

v. <target name=""Commit.Add"">

<exec program="C:\Program Files\VisualSVN Server\bin\svn.exe"
commandline="add --force *.*"
workingdir="${assemblies.dir}" />

<exec program="C:\Program Files\VisualSVN Server\bin\svn.exe
commandline="commit -m&quot;Release&quot; --

username PJL --password PJL"

workingdir="${assemblies.dir}" />

</target>
= Commit.Add target is used to upload the new files generated to
repository path.
= The files to be uploaded must be placed into
C:\CC.Net\SalesSystem\Assemblies folder and they will be
committed into http://sc-
training.eimsdirectl.local:8080/svn/SalesSystem/Assemblies path
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8. Development life cycle

The next section describes the recommended developer workflow for C# development. This workflow is
utilized AFTER the initial setup of the model for C#, including packaging, .NET assembly modeling,
etc.

Developers
Using this methodology, developers should not use the Code Library Wizard during normal

development. Instead developers should rely on the Default Code Library Name in their Gen and Build
options defined below.

System Properties |
P _ =
(A 320 v Buid I™ Build for NET CLF Debugging
M CH Build
: Diefault Code Library Name:
@ [atabaze Build B —
ll |PILTEST
%ﬁ’?@ Java Build
L —3
) Additional Ref :
@ Local WinMT Build HOnNSNSIEENEEs

IE:HDDcuments and Settingz\plockyerihy DocumentshC

Browse |

LI Specify the default Azzembly in which to package CH clazzes.

ITI Cancel | Help | CH# build optionz

When you generate and build code, CA Plex will automatically create an assembly with the name of the
default code library. This assembly should be first in the developer’s code library list so it runs when
they test.
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For example, let’s say that the application is made up of assembly1 through assembly5. In the
developer’s environment, their code library list should look like this:

PJLTEST

assemblyl
assembly2
assembly3
assembly4
assembly5

Checking tested code into subversion

Once the developer has tested their code, they should update the group model and update the repository
with their new code and only their new code. A developer should never generate code that they are not
working on. At this point any new functions must be packaged in the model. With regard to building the
code and creating assemblies on the server, there are two options.

1. Using CAPLEX

a.

b.

The developer has put any new functions in packages and if they have created any new
packages they must be put into assemblies in the model.

Once the model is updated to the group and the code has been updated to the repository, a
model can be extracted on the server. Any new code can be extracted from the repository and
built from within CA Plex. The Code library wizard should also be used to recreate the
assemblies. These assemblies should be updated to the repository.

The developer should delete their test assembly (PJLTEST in the example above) and the
new assemblies should be extracted from the repository. The developer has the latest
functionality from other developers and is running their recent changes from the correct
assemblies. They can continue developing and any functions they build will be written to
their test assembly.

2. Using Cruise Control
a. The developer has put any new functions in packages. Since under cruise control the

assemblies do not need to be managed in CA Plex any packages that are to be added to an
assembly must be added to the csproj file for an assembly. As an example, if we have an
assembly called Order, there will be a file called Order.csproj. If | add a package called
SummaryTables it needs to be added to the Order.csproj as shown below in the first and last
highlighted lines.
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!& Order.csproj - Motepad - |EI

Ele Edit Format Wiew Help

<specificversion-False</specificversion>
<PrivatesFalse</Privates
< references
<Reference Include="sSystem" /-
<Reference Include="System.Data" />
<Reference Include="system.xml" />
</Ttemsroup:
<ITemar oups
<compile Include="$(Projectoir)horder.assemblyInfo.cs” />
mpile Include="$(Projectbir ) ordery¥, cs"

(Projecthir)
§CProjectDirih,

</ TTEmGr oups
<Import Project="$(MsBuildeinrath)\micrasoft.csharp. targets” /-
<l—— To modify ¥Dur build process, add your task inside one of the targets below and uncomment Ft.
other similar extension points exist, see microsoft.Common.targets.
<Target Name="Beforeguild">
</Target»
<Target Name="afterguild">
</Target>
-
<PrOpertyEroups
<PEeBu¥?dEvgnt>

b. Cruise Control will rebuild any updated or new functions in the repository and create the
associated assemblies. We can configure Cruise Control to do this as soon as it detects a
change, or at a specified time such as 4am every night. It can also be triggered on demand.

c. Developers then get the update assemblies from the source repository.

d. After the new assemblies are extracted, the developer should delete their test assembly
(PJLTEST in the example above) and the new assemblies should be extracted from the
repository. The developer has the latest functionality from other developers and is running
their recent changes from the correct assemblies. They can continue developing and any
functions they build will be written to their test assembly.

Either of these work flows can be modified over time to suit your exact needs. ADC Austin
recommends cruise control for large applications, as a proven production-quality solution that can
more completely automate the C# build process.
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Appendix

Document from CA Plex Sample Model
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Introduction

CA Plex r6.0 introduces the ability to generate your server-based applications as .NET managed
code applications. Functions given a language of C# are generated as C# class files, which are
then compiled into assemblies and are run using the CA Plex .NET runtime.

Whilst many of the concepts associated with Plex .NET applications will be very familiar to most
Plex developers, the .NET platform introduces a number of new concepts and improvements
which this document addresses.

The main topics that this guide covers are:

(1)
(@)

3)
(4)

(5)

Prerequisites: What you need to have installed in order to successfully run these examples.
Running a Simple Client-Server Application: Shows the steps required in order to generate,
build and run a Plex application based over the pattern libraries.

Using the Plex .NET Runtime Service: Shows how you can configure Plex generated .NET

Server applications to use the new Plex .NET Runtime Service.

Visual Studio 2005 Integration: This section shows how to integrate Plex generated .NET

applications with other client applications.

(a) Stateful Calls: Shows how you can make calls into the Plex runtime where a client is
bound to a Plex runtime server instance, so that transaction, cursor and other information
is maintained between calls to the runtime. This example is based over a Windows
Application developed in C#.

(b) Stateless Calls: Shows how you can make calls into the Plex runtime where a client is not
bound to a Plex runtime server instance. This example is based over an ASP.NET Web
Application, also developed in C#.

Using Code Library Objects to Create Assemblies: This section shows you how to divide your

application into logical deployment units, and how to deploy these units as an application.
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(1) Prerequesites
In order to run this example, you will need a minimum of the following installed on your PC.

(1)
(@)

3)

(4)

CA Plex r6.0 or later version.

Microsoft SQL Server: You should be able to build the database schemas for this
example against any version of SQL Server, although SQL Server 2005 is
recommended. For a comparison of SQL Server 2005 editions, refer to the Microsoft SQL
Server Website.

Microsoft .NET Framework Version 2.0 Redistributable Package: The version
recommended is v2.0.50727, and is available from the Microsoft .NET Framework
Website. It is also installed by default with Microsoft Visual Studio 2005.

Microsoft Visual Studio 2005: Although the .NET Framework Version 2.0
Redistributable Package contains the tools necessary to build generated C# source code,
you will need to install Visual Studio 2005 in order to compile the Plex generated
unmanaged C++ Client applications used in this example, and also to integrate your
generated Plex .NET server applications with other 3" party client applications. This is
especially true if you would like to take advantage of the new CA Plex r6.0 .NET Runtime
API layer. Version 8.0.50727 or above is recommended.



http://www.microsoft.com/sql/default.mspx�
http://www.microsoft.com/sql/default.mspx�
http://www.microsoft.com/downloads/details.aspx?familyid=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en�
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(2) Running a Simple Client-Server Application

Introduction

The following example uses the sample model SalesSystem.mdl that can be found in the
Samples\Dot NET Support and Code Libraries\ directory.

The sample consists of three relatively simple entities that comprise a Sales Order System;
Order.Header, Order.Detail and SalesSurrogateSystem; the latter is a support entity used to
maintain information on order keys that have been allocated.

0 Detail
T Header
) SalesSurmogateS pstem

As you can probably imagine, Order.Detail is owned by Order.Header. Both Header and Detail
obtain their primary keys automatically by inheriting from patterns that allocate surrogate keys.
Header inherits from FOUNDATION/Surrogate and Detall inherits from
FOUNDATION/SurrogateOwned (so that the primary keys are allocated uniquely within their
super-ordinate keys).

All three entities have database tables and views associated with them, and as such, they inherit
from STORAGE/RelationalTable.

In order to generate and build this example targeting a Windows C++ client running to a C# .NET
server, we simply need to set the relevant variants for the libraries attached to SalesSystem from
which it inherits. Because the Windows C++ client is the default variant for the client pattern
libraries, this only means we have to set the STORAGE library to a variant of *.NET server’.

kd odel " ariant Lahguage W ersion
Grouphiod Baze Baze Baze Base
ACTIVE Baze Baze WE.0 Patterns WE.0 Patterns
OATE Windows client Baze WE.0 Patterns W60 Patterns
FIELDS Baze Baze WE.0 Patternz WE.0 Patternz
Foundati Baze Baze WE.0 Pattermns WE.0 Patternz
AT =] Baze Baze WE.0 Patterns WE.0 Patterns
OBJECTS Baze Baze WE.0 Pattermns WE.O Patters
STORAGE +| Baze WE.0 Patterns WE.0 Patterms
LIEASIC Z Baze WE.0 Patternz WE.0 Pattermz
LUISTYLE Baze Base WE.0 Patterns WE.0 Patterns
W vairjgégr:;f;ewer P Baze WE.0 Patterns W60 Patterns
WM AP Jais Oracle zerver Baze WE.0 Patternz WE.0 Patternz
- |JetEngine Server
MT ODELC server ﬂ

This has already been set in the SalesSystem model for you. The only thing you need to do in
order to run the example is to generate it, build it and configure the Plex .NET Runtime so that the
client can call the server. The following steps will walk you through this process.
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(1) First, you will need to configure the database to which you wish to run to. In order for Plex to
build the necessary table and view schemas, you will need to configure an ODBC data
source to connect to the database. The remainder of this document will reference a data
source called ‘development’ that connects to a SQL Server 2005 instance.

-

ODBC Microsoft SOL Server Setup

=,

A new ODBC data zource will be created with the following

configuration:;

Micrazaft SOL Server ODBC Driver Yerzsion 03851117

Data Source Mame: development

Data Source Description: LAYRO07-DEDDNdevelopment
Server .

D atabaze: development

Language; [Default]

Translate Character Data: ez

Lag Lang Runhing Quenes: Ma

Log Driver Statistics: Mo

Ilze Integrated Securiby: Mo

|1z Regional Settings: Mo

Frepared Statements Dption: Drop temporary procedures on
dizconnect

Ilze Failover Server: Mo

Ilze AMSI Quoted |dentifiers: Yes

Ilze AMSI Mull, Paddings and " armings: ves

Data Encreption: Mo

Test Data Source... k. | Cancel |

(2) With the model open, go to the Generate and Build window by selecting Tools>Generate
and Build... from the main menu. Take a few moments to review the settings associated with
the model by selecting Build=>Generate and Build Options.... Out of all the settings, take
special note of the following:

(a) Build Directories: Make sure that you set the build directories.

(b) C# Generation Options: This tab contains options that affect the generated C# source
code. Currently, the only option is the Default generation package. This defines the .NET
namespace into which a Plex generated C# function will be placed if it is not assigned to
a Plex Package object. As none of the functions in this simple example have been
modeled into packages, this will be the namespace into which our generated C# classes

(©)

will be placed.

System Definitions/<Local machine name>/C# Build: This tab contains the options

required for building C# source code.

() Build for .NET CLR Debugging: Does exactly what it says.

(i) Default Code Library Name: Defines the name of the assembly dll into which Plex
generated C# functions will be placed when they are built from the standard
Generate and Build window. Deploying Plex generated .NET applications will be the
subject of a separate discussion on Code Libraries.
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3)

(4)

(5)

NET Support and Code Libraries
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(iii) Additional References: Allows you to specify additional .NET assemblies that your
Plex generated C# functions might reference. For example, you may add C# source
code to your action diagrams that reference external .NET components or pre-built
Plex C# functions from another Plex model.

(d) System Definitions/<Local machine name>/Database Build: This is where you set the
options used when generating database schemas to an SQL database. Make sure you
select the ODBC data source you defined in (1) so that Plex can automatically generate
the necessary database schemas.

Select the subject area called ‘Generate and Build Me’, and generate the source for this
subject area (Build=>Generate). You should be prompted to generate 37 objects. Once the
generation has completed take a look at the directory into which the source has been
generated.

EID Samplez
~{Z] Comlrpart
~{_] Dot NET Connect

The ‘Gen’ directory contains all the C++ source and
ODBC schemas

: A new directory called ‘Src’ is created under the
ED Lien — root where the C# source is to be generated. The
E||:| S actual source is generated into directories that
D Order match_ the _Plex P_ackage names into Which_ the
Function objects will be generated. Note that if we
D Syztem didn’t define a Packages for Functions, that they

are assigned to the Default Generation Package
from the C# Generation Options.

Reselect the subject area ‘Generate and Build Me’, and build the source for this subject area
(Build=>Build). You should be prompted to build 15 C++ functions and 22 C# functions/ODBC
objects.

Highlight the Function in the Subject Area ‘Create an Executable for Me’' and select
Build>Create Exe in order to create a client executable entry point for the application. Now
look at the generation directories to see the locations of the various binaries that comprise
this application.

El{:l Samples

The new ‘Bld’ directory corresponds to the ‘Src’
D Comlrmport directory created during generation. It contains the
D Dt MET Cormectars entire source built from the_‘Src‘ directory. In this

o example, it relates to a single assembly called
HD Dot MET Support #d Code Libraries SalesSystem.dll. This is called a ‘default assembly’

=0 Gen that the Plex .NET runtime can reference in order
: D Bld for clients to make calls to any function generated
for the local model.
{:I Froject
l:l Releaze v
EH:I S The ‘Release’ directory contains all of the
D unmanaged C++ client binaries, consisting of dll,
‘ Order o
i pnl, exe and ini files.
| Sypshem
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(6) In order for the Plex generated .NET Server application to connect to the database, an
OLEDB.NET connection must be used. This example uses a Microsoft Data Link (UDL) file in
order to connect to the database. A sample UDL file is located in the Samples\Dot NET
Support and Code Libraries\ directory for you to configure for your particular
database. Double-click the file in order to -configure it. The following shows
SalesSystem.udl configured to access the development database described in (1).

-,

Data Link Properties

Prowider Connection l.ﬁ.dvanced] All ]

Specify the following to connect to SOL Server data:
1. Select or enter a zerver name:

j Refrezh

Z. Enter information ko log on bo the server:
(+ |Jze Windows MT Integrated security

" Use a zpecific user name and pazsword:

[ [
3. Select the databaze on the server:
|develnpment ﬂ

(" Attach a database file az a database namme:

k. | Cancel | Help |

(7) Now locate the Plex .NET Runtime directory under the main CA Plex r6.0 directory (called
‘Ob.NET"). The Plex .NET Runtime is structured as follows.

= |2 ObMET -—
- The top-level Ob.NET directory contains various batch

= [ bin files used to simplify the installation of the Plex .NET
+ ) Dsgug Dispatch Service.
+ ) Rele
I bId

The ‘bin’ directory contains both Debug and Release
versions of the Plex .NET runtime.

The ‘bld’ directory contains build support files used to
compile Plex generated C# source; these files were
used when compiling the C# source in step (4).
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In order to run our Plex client-server application, we must first configure the Plex .NET Runtime
instance that we wish to run the generated Plex .NET server application under. Because we will
be running the server application as a console application which is started via
PlexRuntimeConsole.exe, we need to configure the configuration file
PlexRuntimeConsole.exe.config.

(a) You can configure the Plex .NET Runtime using the new CA Plex .NET Management
Console. Start the interface by double-clicking the executable
PlexManagementConsole.exe, which is located in the
<PlexDirectory>\Ob.NET\bin\Release\ directory or use the start menu item —
Start/Programs/CA/CA Plex r6.1/Plex .NET Tools/Application Management Console. By
default, the CA Plex .NET Management Console opens two configuration files —
PlexRuntimeConsole and PlexGenericRuntime. For the .NET Console runtime, we need
to update the PlexRuntimeConsole configuration file.

(b) The .NET Management Console allows you to maintain configuration information on the
following items.

The top-level node contains the global configuration
information for the .NET runtime instance, such as
B maximum clients, default culture information, logging
= ‘ FlexRuntimeConzole type and listener ports.
=I-_ Ervironments
= Default N———— | ‘Environments’ contains configuration data that is on a
e Diefault per-connection basis, such as assembly and additional
=3 Locations resource locations, connection culture information,
S5 Default CHf
B [efault BPG Environment nodes also contain one or more
& Default Jave Database nodes. These contain configuration
’ information used when connecting to databases via
the Plex .NET runtime. The primary one of interest is
the UDLFileName setting.

‘C#/RPG/Java’ nodes contain the configuration data
needed to make n-tier connections to other platforms
that host Plex generated applications.
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(8) Highlight the environment called ‘Default’ to see its settings. Highlight the AssemblyList
parameter, browse to the assembly SalesSystem.dl 1 built in step (5), and click OK.

£ CA Plex .NET Management Console

File  Action Edit  Service Help

jﬂ]. b;lgalf“]f__l _IJ_._,|_..5 __,Je,_'..

Q3

= WASOLOT-GH7ES
..D Service
= ‘ PlexRuntimeConszole [C

e

= Ervironments Culbure
=l Detault B Preferences
L Default CharacterTnmS paces
= Location: B Special Field Yalues

i TR TN Y O 2 N

=5 Default Ci -
Default FPG AssemblyList
2 Default Java

>

multiple entries with zemicolons.

A list of azzembly names to be searched when loading Plex .MET function clazzes, Separate

de LibrariesA\GENABIAAS alesSyztem. dil: ™
en-US

True

Highlight the database called ‘Default’
SalesSystem.udl file defined in step (6), and click OK.

£) CA Plex .NET Management Console

under the environment and browse to the

Eile:

UDLFileMame

E_g Default CH#
B Default RPG
2 Default Java
‘ FlexGenenchuntime [C:40

ser

UDLFileMame
Full path name to the UDL file.

Action  Edit Service  Help
- NN ECWR SR NN RE A NENEN X W2l
= WASOLO G755 |E|_:|4H'
.-D Service =
= ‘ PleRuntimeCongole [C:AD = Databasg
=-CF Enviranments AutoCommit True
=@ Defaul Password
b Default HeaanI_l,u’-tn.ccess Falze
=-CF Locations Sqlﬂuery_Tlmeuut_ 60 __
Tranzachionlsolation Unspecified

pport and Code Libraries\S alesS ystem. ud [l

(9) Save the configuration file by selecting File>Save All, and exit the Plex .NET Management

Console.

(10)To start the server application, double-click the PlexRunt

imeConsole.exe executable or

use the start menu item Start/Programs/CA/CA Plex r6.1/Plex .NET Tools/Start .NET
Runtime Console. A DOS-style command window should appear, telling you that the Plex
.NET Runtime Console has been started, and is listening for requests on port 1998 (this is
defined in the Port setting under the root node of the configuration file).
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Start .NET Runtime Console

Found Configuration File [C:<Documents and Settings~All Users“Application Data\Cu
A~Flex™b .1“o0b_Het“Release“PlexRuntimeConsole.exe.configl
[PLEXBAB42]1 CA Plex .MET Runtime Console started. .

(11)Locate the Plex generated client application in Samples\Dot NET Support and Code
Libraries\Gen\Release\ directory. In order for the Plex generated client to call the
server application, it needs to be configured to connect to the server (although the client and
server are running on the same machine, the principle is the same as if they were located on
different machines). To configure the client runtime, open the file HeaderGrid. ini. This
contains a section called [RemoteCSharp] that contains the connection information to
connect to the .NET server. The primary values of interest are:

(a) System: The name of the system on which the Plex .NET server application resides.

(b) Port: The port number that the remote machine is listening on.

(c) Environment: The name of the environment on the server that contains the configuration
information for the application.

Because this example is running to the local machine, on port 1998 using the default
environment, these values can be left as they are.

(12)To run the application, double-click HeaderGrid.EXE to start the client application. Try out
the application by doing the following:

(a) Enter some header records using the ‘Add new data.’ Button.
(b) Enter some detail records for a selected header by selecting the ‘Detail’ button.

You can check the server status by checking the text log file associated with the server
runtime. You should see trace messages created in a file called
PlexRuntimeConsole.TCPIP.1998.<timestamp>.log each time a server function is
called (this can be switched off by a configuration setting in the runtime). The log file location
is C:\Documents and Settings\All Users\Application Data\CA\Plex\6.1\ob.Net\log or
C:\ProgramData\CA\Plex\6.1\ob.Net\log, depending on the OS. The trace messages should
all be informational, and should look as follows.
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BB PlexRuntimeConsole. TCPIP.1998. 20080714_041536. log - Notepad

File Edit Format Wiew Help
FeLld,/2008 4:15:36 PM Type=2 [PLExQ016] sStarting CA Plex .MET Runtime Console on port
1

7/14,/2008 4:15:36 PM Type=2 [PLEX0042] CA Plex .NET Runtime Console started.
7/14 /2008 4:17:21 PM Type=4 [PLEX0001] Started client session. Client=127.0.0.1
7/14 /2008 4:17:21 PM Type=4 [PLEX0003] Received request to call function
order.HeaderglockFetch_obFnc, Client=127.0.0.1

7/14,/2008 4:17:33 PM Type=4 [PLEX0003] Received request to call function
Order.HeaderInsertRDw_OEFnc. Client=127.0.0.1

7/14,/2008 4:17:40 PM Type=4 [PLEX0003] Received request to call function
order.HeaderInsertRow_ObFnc. Client=127.0.0.1

T4 2008 4:17:47 PM TyEe=4 [FLExCO03] Received request to call function
order.HeaderinsertRow_ObFnc. Client=127.0.0.1

7/14/2008 4:17:48 PM Type=4 [PLEX0003] Received request to call function
order.HeaderglockFetch_obFnc. Client=127.0.0.1

A

You have the choice of directing Plex .NET Runtime messages to either a trace log file, or the
Application Event Log. You can select where to send the messages via the configuration file
associated with the Plex runtime you are executing.

The trace file or event log should also be the first place to look if you have problems with your
Plex .NET Runtime.
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= =] = & = Detai
Ordert urnber Cuztomert ame OrderD ate

Rob's Records
Fiposhi's Lamp Co.

Faul's Boutique

2]

2M3/2007
2M19/2007

OrderMurmber | LineMumber Productt ame
Widgets
Dongles

Tartan Paint

Lineluattity LinePrice

19395
34.93
2000.50

Hrderdurmtes I 1

Productt ame

LirneG uartity I 5

LinePrice I 199,95

Mew | Delete | Hefreshl

Continue new? [

(13)Close the client application and the Plex .NET Runtime Console before continuing to the next

section.
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(3) Using the Plex .NET Runtime Service

Introduction

In addition to running the Plex .NET Runtime as a console application, you can also run your
server applications under a service on the target machine.

Running your Plex .NET server applications under a service has a few noticeable benefits:

1)

()

®3)

You can configure multiple ports on which to service Plex client applications. These are
called ‘Listeners’, each of which has their own unique configuration information, memory
space and state information.

The configuration of these listeners can be carried out by the Plex .NET Management
Console interface, thereby making it simple to manage the application instances you have
installed and running on a particular server, even remotely.

You can obtain extended diagnostic information on your running Plex .NET server application
instances for each listener. This includes information on active threads, database
connections, SQL statement execution and remote n-tier connections that have been made in
the runtime.

In this example, we will configure the application generated in section (2) Running a Simple
Client-Server Application to use the new Plex .NET Runtime Service.

Steps to Configure the Plex .NET Runtime Service

1)

(2)

If you selected the .NET Runtime option on the Plex install ‘Select Features’ screen, the CA
Plex r6.1 .NET Runtime Service should be already installed. To install the service, you need
to use the .NET Framework utilty #nstallutil on the service executable
\Ob.NET\bin\Release\PlexRuntimeService.exe.

For convenience, batch files to install and uninstall the service are installed in the Ob _NET
directory. To install the service, double-click on the batch file
\Ob.NET\InstallService.bat. Once installed, you should be able to see the Plex .NET
Runtime Service installed under the Services node in the Microsoft Management Console. Do
not start the service yet — we will do that a bit later.

CA Plex r6.1 .MET Runtime Service Properties (LocalC... @E|

General | Log On || Recovery || Dependencies

Service name: Ca Plex 6.1 .NET Buntime Service
Display name: oy Plew 6.1 .MET Buntime Service
Diescription: Enables connections from remote Ca Plex CH, WinC

and Java applications

Now open the Plex .NET Management Console. You should see a service node appear
under the root machine node in the left-hand tree view. The red square against the service
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node denotes that the service is currently stopped. You can now use the Plex .NET
Management Console to control the service installed on the local machine.

i e dNagemne onsole L]
File  Action Edit  Service Help

P B X e o @iy 3y @ @7
= WASOLOT-G=755

] Service
FlexRuntimeCaonzole [C
=3 Enviranments
=@ Defaul
b Defaul
=03 Locations

8 Defaul CH
B Detault RPG
ol Default Java

[

| |

2
— —

(3) Select the service node, and select Service->Start in order to start the Plex .NET Runtime
Service. After a brief pause, the service node icon should change from showing a red square
to showing a green arrow, showing that the status of the service has changed into the
running state. The service node should also have a (+) next to it showing that it contains
additional information. Expand the service node and select the listener node called ‘Default’
running under the service.

CA Plex .HET Management Console

A Listener node represents one
Plex .NET Runtime instance
running on the server.

File  Action Edit  Service Help

P S X

- W WL W

= VASOLO G755 -~ i i
= .. Service — Emne Parth Each listener node contains its proclient | Co
L Dietii TLRIP own set of configuration
E'-.'ﬂ = information displayed under the
- # Default [C:\Dot listener node.
-3 Threads

m Wiews If a listener node is running, then
m FemateCanver additional information on that
Q Logs runtime instance is available in the

=i PlexRuntimeCongale (C information nodes.

=3 Enviranments

: &
[T
—

(4) To make sure that we're not using the default listener, stop it by selecting
Service>Listeners>Stop. You should see that the green arrow icon next to the listener
node changes to a red square. The configuration and information nodes under the listener
should also disappear.

(5) To add a new listener, select Service>Listeners>Add... You should be presented with a
dialog to enter the unique listener details, which consist of the following:
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(a) Listener name: The name used to identify the listener. This name is also used to set the
name of the .config file used to store the configuration information on the server for the
runtime instance.

(b) Port number: This is the unique port number that the listener will take incoming requests
from Plex client applications.

(c) Autostart: By selecting autostart, the listener will start running as soon as the .NET
Runtime Service starts. If autostart is not enabled, then the listener must be started
manually once the service enters the running state.

Enter ‘Listener2006’ for the listener name, 2006 for the port number and leave autostart set to
true, then select ‘OK’.

Add listener

Enter the details aszociated with the liztener instance here.

[0k

Liztener name: | isteners

Part number: 2006

Autostart when service starts

[ ak. l [ Cancel

(6) You should see that Listener2006 has been added under the service, and because it was set
to autostart, it should be running. Select the new listener node in order to load the
configuration file associated with it. Highlight configuration node and select
Add->Environment to create a new environment entry. Enter ‘SalesSystem’ for the
environment name, and press enter.

£) CA Plex .NET Management Console E|@|g|
File  Action Edit  Service Help
B I EX TN YN Y Yol
= 2 VaSOLO1-GX7ES S
. Sl || Z
= .-, Service — -
oy Default = EBHELTIL'
[y Listensr2008 ssemblplist
=¥ Listener2005 [C:\Doc Culture enUS

=1 Environments = Prelerencgs
@ Defaul CharacterTrimSpaces True

El Special Field ¥alues

ol 4 b Defaul CharacterE mptys alue
£3 Locations CharacterHighy alue z
L7 Threads Characterl owialue
7 DBConnections Datek mptyt/alue 0001-01-01
S Views DateHightvalue 9993-12-31
B FemateConversations Datel osalus nnm-n1-ni b
:::E Logs AssemblyList

A4 list of azzembly namesz to be searched when loading Plex MET function claszes.

= ‘ PlesRuntimeConsole [C:\Doct & Separate multiple entries with semicolons.

< b
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In the AssemblyList parameter of the newly added environment, and enter the path to the
assembly SalesSystem.dl 1 built in the previous example.

£ CA Plex .NET Management Console
File  Action Edit  Service Help

P DB X o a3 3@ @R
= B vASOLDT-GXTES ~ E_H’ |
= “, Service ——
o Diefault B General A
) e Listener2008 List TS SN NS alesSystem. dil; |
=) Listener2006 (C:\Doc Cukture en-US
=+ Environments = Prelerencgs
Bl Defaut Eharau_:terT{lmSpace& True
=l SalesSystem Bl Special Field ¥alues
}.‘-5 Default — CharacterE mpty'/alue P
Em Locations CharacterHigh'/ alue z
5% Threads CharacterLowtfalue
I_E'.. DECanmections D ateE mptyty alue ooo01-01-01
I_; Views DateHigh/alue 9999-12-31
- FlemoteCortersafions Natel mwiale nnni-ni-nm M
t?'., Logs AszemblyList
= ‘ PIE:-:FETmtimeD:mole [C:\Dacy v & fist of asserr!hly names ta_be sealched when loading Plex MET function claszes.
2 I - —|'| Separate multiple entriez with zemicolons.

(7) Highlight the database called ‘Default’ under the new environment. Browse to the
SalesSystem.udl file.

£) CA Plex .NET Management Console

File  Action  Edit  Service  Help
- NN S | X b o @i 3] 3@ @ |7
=] WVASOLOT-Gx755 » %_: Al
= .-, Service —= =
a:“ Diefault = Dalahasg
g Listener2006 AutoCornrnit True
= # Listener2006 [C:\Dac Password
=4 Enviranments Headlzlnly.-'%-.ccess Falze
Bl Defaul SaldueryTimeout GO
=l SalesSpstem Tranzactionl zolation Unspecified
% Defalt LIDLFileM ame it and Code Libraries\ErEre o ml..)
[ Locations User
3 Threads
7 DBConnections
3 Wiews
7 RemoteConversations :
3 Logs UDLFileMame .
=iy PlesRuntimeConsale (ChDocy » Full path name to the LIDL file.
< | S

(8) Save the configuration file by selecting File->Save All. This will save the configuration file
onto the server. If you want to view the configuration file it is located in the same directory
where the service executable resides (i.e. \Ob_NET\bin\Release\).
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(9) The service and listener are now ready to receive connections from a Plex client application.
Locate the Plex generated client application in Samples\Dot NET Support and Code
Libraries\Gen\Release\ directory. Open the file HeaderGrid. ini, and change the
section called [RemoteCSharp] as highlighted below.

[RemoteCSharp]
System=localhost
OpSys=WINCLR
Protocol=WINTCPIP
Port=2006
Environment=SallESSYSEEN

Timeout=60

Client Encoding=Windows-1252
Program=

Path=

Buffer Size=1

Package=

(10)Start the client application and make sure everything works as expected; it should work
exactly as it did before. Now start up a second client on the same machine, and make some
more server calls by adding, updating or deleting records.

(11)Open up the Plex .NET Management Console and look at the following information displayed
for the listener.

(a) Listener node: Shows properties associated with the listener, such as current number of
clients connected, total number of clients serviced and other runtime configuration
properties such as the logging type and level.

(b) Thread node: Shows information on each individual client currently connected to the
listener, such as the machine name, IP address and number of client to server calls.

(c) DBConnections node: Shows information on each database connection currently
active, such as connection string and connection type.

(d) Views node: Shows information on the individual SQL statements currently open. You
can see the SQL statements executed and the Plex server functions they were called
from.

(e) Remote conversations node: Shows any .NET Server to .NET/Java/System i
connections that might be active against the listener.

() Logs node: Shows runtime log messges.
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CA Plex .MET Management Console

File  Action  Edit  Service  Help

A N BON-CRh AR N SR NN - Sl

= @ WASOL-GX7E5 Sl ConnectionType Parthurmber ThreadM ame Cligntt arme
= o S—e.”’t'fef ) TCRIP 2006 Cliert #5 VASOLOT-GX7E5.ca
sy Defau
EI:?_: Listener2006 | TCRIP 2008 Clignt #2 VASOLO-GX750.ca

= ¥ Listener2006 [C:\Doc
o -3 Envionments
[+ Locations

: |
-

| ] l._

(12)Close the client applications and stop the Plex .NET Runtime Service before continuing to the
next section.
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(4) Visual Studio 2005 Integration

Introduction

The CA Plex .NET Runtime allows simple integration with other applications based on the .NET
platform by using the DataSet and other associated classes from the System.Data hamespace in

the .NET Framework.

When calling a Plex generated function, a DataSet represents either the input or output variable
groups associated with that function. DataTables are used to represent the individual variables
within the input or output group; with individual DataColumns used to represent the fields of those

variables.

InHeaderBlockFetch (.Input)

Position

OrderNumber

A DataSet represents a parameter
interface variable group from Plex.
Input contains both input and dual
variables.

Control

Position

RowsFetched

A DataTable represents one variable
on the parameter interface.

A DataColumn contains the
information on one field in the variable
on the parameter interface.

OutHeaderBlockFetch (.Output)

FetchedData

OrderNumber

CustomerName

OrderDate

Rob’s Records

01/01/2006

Kiyoshi's Lamp Co.

A DataRow contains the actual field
data passed to and from the function
call. If the variable is a single instance,

02/02/2006

A

v

A then there will only be one DataRow in
the DataTable instance. If the variable
\ 4 is a MOV, then there will be a

Cheeky’s Loop Store

DataRow object for each instance

10/21/2006 passed to or from the function.

This section consists
runtime.

of two examples,

showing both a stateful and stateless call into the Plex
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At the end of a stateful call into the Plex runtime, the thread used by the client is maintained for
subsequent calls into the runtime. This allows a client application to maintain cursors between
calls into the Plex runtime.

At the end of a stateless call into the Plex runtime, the thread used by the client is discarded.
Thus any cursors that may have been opened during the call are lost. To make a stateless call
into the Plex runtime, you need to use the static cal lFunction() method exposed on the
ObRun.ObUtiIs.ObUserApi class.
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(A) Stateful Calls

(1) Open Visual Studio 2005 and create a new Visual C# Windows Application project, or open
the supplied Windows Client project. The following shows a screenshot with the settings for

the completed example under the \Samples\Dot NET Support

and Code
Libraries\Visual Studio 2005 Clients\ folder.
Hew Project K
B0 | oo
Project types: Templates: B ’;
- Wisual CH Ewmdaws Application 4@ Clazs Library
-- Other Languages é‘cEWindows Control Libramy 3 Console Application
[+ Other Project Types E Cryztal Reports Application E Device Application

| Search Online Termplates. ..

& project far creating an application with a Windows uzer interface

Marne: I"u\-’indows Client
Location; CarslFugsion Ples 6,045 amplesi\Dot NET Support and Code Libraries al Studio 2005 Clientid
Solution: IEreate new Solution ﬂ W Create directam for solution

Solution Marne: windows Client [ &dd to Source Contral

Browse... |

o]

Cancel

(2) Open Forml.cs in design view, and add a DataGridView control to the dialog.
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2 Vizual Studio 2005 Clients - Microzoft ¥izual Studio

File  Edit “ew Proect Buld Debug Data Toolz Window Community  Help

i S e o | % S (9 -8B | b Debug - &y CPU =

TR L T RS I
Form1.resx* ]/ Farml.Designer. cs* /VFulml.cs [Design]* * X

Brom R =TE

LA
1

|

b

& Painter
27| DataSet

=
te

| DataGrndView
Wergion 2.0.0.0 from Microzoft Corporation
| .MET Component

4 Dizplays rows and columns of data in a gnid vou can
4 customize.

I‘}@ Toolbox ]I@ Solution Explorer

[.3 Errar Listl@ Elutput]
Ready

(3) Double-click on the main body of the form to add an event to handle the Load event for
Form1. Visual Studio should jump to the code view for Forml.cs file, in a new method called
private void Forml_Load(object sender, EventArgs e).

(4) Select Project>Add Reference... from the main menu. From the Browse tab, navigate to
where the Plex .NET Runtime is located (this should be under the \Ob.NET\bin\Release\
directory). Add Plex.ObRun.dll and Plex.Controls.dll as references to your project.
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Add Reference

MET | COM | Projects | Browse |Recent

Look, jr: |l.i' Release v| € ¥ e M-
hia-aP [FAPlexruntimeservice. exe
%] Inkerap. PlexAPILib.dl Flvarzsml exe

dﬂPhLCDmmnmd"
L’-ﬂ Plex, Controls, Designers. di

f_",i' FlexManagernentConsale, exe
EPlexRuntimeCDnsnle.exe

File name: |“PhanHundP“PEaEaMmde' Vl
Files of twpe: | Companent Files [ dll;” Hb;* olb;" ocx;” exe;”. manifest) v |
oK ][ Cancel ]

(5) Add the following code at the start of Form1.cs after the using sections for the .NET runtime.

using ObRun.ObMain;
using ObRun.ObUtils;

(6) Add the following code to the method private void Forml _Load(object sender,
EventArgs e):

DataSet dslnput; // A DataSet to hold the iInput parameters.
DataSet dsOutput; // A DataSet to hold the output parameters.
DataSet dsOutputGrid; // A DataSet to hold the data to be displayed on the grid.

// Create a new Plex _NET Runtime instance.
ObApplicationUser app = new ObApplicationUser();

// Initialize dslnput with:

// - A DataTable that is initialized with the default

// Calllnfo structure for the call.

// - DataTables that contain each of the input/dual variables
// used for the call.

dslnput = ObUserApi.getlnputParmDataSet('Order.HeaderBlockFetch_ObiIn™);

// Set up any additional call information in the Calllnfo DataTable.
dslnput.Tables["CallInfo'].Rows[O][“Environment™] = "Default";

// Set up any additional parameters for the call in the appropriate

// DataTable instances.

// Note the use of "In" to prefix the table name.
dslnput.Tables["InHeaderBlockFetch_Position'].Rows[0]["'OrderNumber'] = O;
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dslnput.Tables["InHeaderBlockFetch_Control*].Rows[0][**'S5trh2n*] = "Y";

// Create the schema for the accumulated dsOutputGrid.

// Note: We could have waited until dsOutput was populated and then cloned

// it"s schema, but this shows the use of another Plex runtime API.

dsOutputGrid = ObUserApi.getObVariableGroupXAsDataSet(*'Order .HeaderBlockFetch_ObOut™);

// The FetchedData output MOV is returned initialized, so clear it prior to use.
dsOutputGrid.Tables[""OutHeaderBlockFetch_FetchedData'™].Clear();

// Set the DataGridView.DataSource object to the FetchedData MOV.

// FetchedData is one of the output variables returned in dsOutput as

// a DataTable object.

// Note the use of "Out” to prefix the table name.

String returnedStatus = " *;

Int32 rowsFetched = 0;

while (returnedStatus == " ')

{
// Call the Plex function via the Plex ObCallIManager.obCal IFunction() method.
dsOutput = app-M_ObCallMgr.obCallFunction(dslnput);

// Set up the returnedSatus and rowsFetched values passed back.
returnedStatus = dsOutput.Tables["'PlexSystem'].Rows[0]["'Returned'].ToString();
rowsFetched =

Int32.Parse(dsOutput.Tables[" InHeaderBlockFetch_Control'].Rows[0][''S5trh30'"].ToString());

if (rowsFetched > 0)

// Use the ImportRow method to copy from dsOutput to dsOutputGrid.

for (int 1 = 0; 1 < rowsFetched; ++i)

{
DataRow dr = dsOutput.Tables['OutHeaderBlockFetch_FetchedData'].Rows[i];

dsOutputGrid.Tables["OutHeaderBlockFetch_FetchedData'] . ImportRow(dr);

}

// Set up the parameter DataSets for the next call.

dslnput = ObUserApi.getlnputParmDataSet(*'Order.HeaderBlockFetch_0OblIn™);
dslnput.Tables["'CallInfo'].Rows[O]["Environment'] = *"Default";
dslnput.Tables["InHeaderBlockFetch_Control™].Rows[0]["'S5trh2n"] = "N";
dsOutput.Clear();

// Set the DataGrid DataSource equal to the DataTable built from the
// Blockfetch call.
dataGridViewl.DataSource = dsOutputGrid.Tables["OutHeaderBlockFetch_FetchedData'];

(7) Compile the project by selecting Build>Build Solution.

(8) Before running the example, you need to have Plex .NET Runtime configuration information
in the configuration file associated with the Windows Forms executable. The simplest way to
do this is to copy the configuration file you used to run the example in section (2) Running a
Simple Client-Server Application.

Copy the file \Ob.NET\bin\Release\PlexRuntimeConsole.exe.config to the
location where your client executable will be executed, and change its hame to Windows
Client.exe.config, as shown in the following diagram.
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Mame = Size  Twpe Drake Modified
Chia-IP File Falder 4412007 5:33 PM
Interop, PlexaPILib, di 11 KB Application Extension 313002007 Sl PM
) ) .
F'Iex CeoErie] 76 KB .ﬁ.pplfca Windows Client.exe.configisa
Ples. Controls. di 64 KB Applical copy of the .NET Runtime Console
Plex . obRun.dll 248 KE Applical -config file used in the previous

. : . example. It is used to locate the class

EWlndnws Clierit exe 20KE  Applica files generated for the Plex .NET
@Windnws Client. exe.config 7EE WML Cof Server Application.
%.I windows Client,pdb 22 KB Program Debug Database 4142007 533 PM

EWindnws Clignt wshost, exe
BWindnws Client, wshosk, exe.config

& kB
7KB

9/23/2005 6:56 AM
4/4/2007 6:09 PM

Application
®ML Configuration File

(9) Run the example by selecting Debug—>Start Debugging. You should see a Windows form
appear, loaded with the Order Header data that you entered in the first example.

o Form1 [._] [E] E
CORCOERMUMBER | CUSTOMERMAME ORDERDATE
4 1 Rob's Records B/ /2006 _I
2 Ko a7 — | Qdendoloatonn
3 PayeBoutique | 7/2/2008 EOV is reached.
4 /ﬁga's Dalma Co. | 7462006
] / Franks Franks Co. | #/3/2008
B Cheeky's F< Corp. | 71042007
7 The Boak Campa... | 71542008
a Donkey Cuztard ... | /252006
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(B) Stateless Calls

(1) Open Visual Studio 2005 and create a new web site by selecting File>New—>Web Site....
Call the web site ‘ASP.NET Client’, and place it on the local file system under the Visual
Studio 2005 Clients folder. Choose a language of C# for the code behind pages
associated with the web application.

The following shows a screenshot with the completed settings for the example under the \
Samples\Dot NET Support and Code Libraries\Visual Studio 2005
Clients\ folder.

New Web Site 7 x|

Templates:

ASP MET ASPMET  Personal'web  Empty'web ASPMET
‘web Sike  ‘Web Service  Site Starter Kit Site Crystal Fepo...

Search Online
Templates...

& blank 85P.MET 'web site

Location: IFiIe System port and Code Librariestisual Studio 2005 Clents'A5P.NET Clientjfid Browse... |

Language: I'V'isual CH

0K I Cancel |

(2) Open Default.aspx in design view, and add a GridView and Button web control to the
dialog.
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& ASP.NET Client - Microsoft Visual Studio [|=15<
File Edit Wew ‘Website Buld Debug Format Layout  Tools  Window  Commonity  Help
j'_l'._jﬂﬂl 1 Jﬂ'.| - e & |PDebug * MET v a
I T T e = §|He><|_3vﬂ

Solution Explorer - So... - I X Default.aspr* +~ ¥ || Toolbox ~ 0 X L%
= e EE R = B8 Local g
=) | | £]59 = Localize =) 5

1 1 1 =)
[ Solution 'ASP.MET Cliert' (1 pi ©olunn0 Colunnl Colunn? - Data i)
= [P Ch\AASP.NET Client, ||| ahe abc abe & Fointer B
j A Data abc abc abc |-’—-| Gridiew

+ 2 .

j Defaule. aspx ] pate-
=] pet Gridview
¥ Version 2.0.0.0 from Micrasaft Corpors
1 For{ MET Component

abc abc abc
abc abc abc
b abc abc

— Repeater

;_] SqlDatasource

LJe AccessDatasource

_‘g ObjectDatasource

[l =miDataSource

rFa (3| [ Design |k Source 4| | =asp:butt » o8 Server Explorer |34 Toolbox

Ready

(3) Double-click on the newly added button on the page to add an event to handle the Click
event. Visual Studio should jump to the code-behind source associated with the aspx page,
called Default.aspx.cs, and be positioned on a new method called protected void

Buttonl Click(object sender, EventArgs e).

(4) Select Web Site>Add Reference... from the main menu. From the Browse tab, navigate to
where the Plex .NET Runtime is located (this should be under the \Ob.NET\bin\Release\
directory). Add Plex.ObRun.dll and Plex.Controls.dll as references to your project.
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Add Reference .

MET | COM | Projects | Browse |Recent

Look in: ||.i' Release v| D F £ -
hia-aP [FAPlexruntimeservice. exe
%] Inkerap. PlexAPILib.dl Flvarzsml exe

dﬂPhLCDmmnmd"
é] Plex, Controls, Designers. di

f_.i' PlexManagementConsole, exe
ﬂPlexRuntimeCDnsnle.exe

File name: |“PhanHundP“PEaEaMmde' Vl
Files of twpe: | Companent Files [ dll;” Hb;* olb;" ocx;” exe;”. manifest) v |
oK ][ Cancel ]

(5) Add the following code at the start of Default.aspx.cs after the using sections for the
.NET runtime.

using ObRun.ObMain;
using ObRun.ObUtils;

(6) Add the following code to the method protected void Buttonl Click(object
sender, EventArgs e):

DataSet dslnput; // A DataSet to hold the iInput parameters.
DataSet dsOutput; // A DataSet to hold the output parameters.

// Create a new Plex _NET Runtime instance.
ObApplicationUser app = new ObApplicationUser();

// Initialize dslnput with:

// - A DataTable that is initialized with the default

// Calllnfo structure for the call.

// - DataTables that contain each of the input/dual variables
// used for the call.

dslnput = ObUserApi.getlnputParmDataSet('Order.HeaderStatelessBlockFetch_OblIn'™);

// Set up any additional call information in the Calllnfo DataTable.
dslnput.Tables["CallInfo'].Rows[0][“Environment™] = "Default";

// Set up any additional parameters for the call in the appropriate

// DataTable instances.

// Note the use of "In" to prefix the table name.
dslnput.Tables["InHeaderStatelessBlockFetch_Position'].Rows[0][*OrderNumber'] = O;
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dslnput.Tables["InHeaderStatelessBlockFetch_Control*].Rows[O][*'S5trh2n*] = "Y*;

// Call the Plex function.
dsOutput = ObUserApi.callFunction(dslnput, false);

// Set the DataGridView.DataSource object to the FetchedData MOV.

// FetchedData is one of the output variables returned in dsOutput as

// a DataTable object.

// Note the use of "Out® to prefix the table name.

GridViewl._DataSource = dsOutput.Tables["OutHeaderStatelessBlockFetch_FetchedData'];
GridViewl.DataBind();

(7) Compile the project by selecting Build>Build Solution.

(8) Before running the example, you need to have Plex .NET Runtime configuration information
in a configuration file associated with the ASP.NET web application. When running in a web
application, the Plex .NET Runtime looks for configuration information in either the
web.config file associated with the web application, or in a configuration file called
Plex.ObRun.dll.config.

The simplest way to do this is to copy the configuration file you used to run the example in
section  (2) Running a  Simple Client-Server  Application, renaming it
Plex.ObRun.dll.config, and placing it in the directory where the web application will be
executing from.

Copy the file \Ob_NET\bin\Release\PlexRuntimeConsole.exe.config to the
location where your client executable will be executed, and change its name to
Plex.ObRun.dll.config, as shown in the following diagram.

Marme Size Tvpe Dake Modified
Chja-IP File Falder 4142007 7144 PM
.ﬂ Interop. PlexaPILib, dil 11 KE Applicatior=——-- bad Adruat

a — Plex.ObRun.dll.configis a copy
'_,j Plexx. Comman. di 7O KB F'.pplfl:atfcnr of the .NET Runtime Console .config
2] Ples. Controls.di &4 KE  Application file used in the first example. It is used
Ples. Contrals.dll refresh 1KE REFRESH tg |Oclate the class files gelnefated fO(;

- the Plex .NET Server application an

‘i-:l Ples . ObRun, dil 245 KB Application | \oke database connections.
@F‘Iex.obRun.dll.cnnﬁg TEKE =ML Configoramomrme = 9200y B OF ErT
Ples, ObRun. dil refresh 1KE REFRESH File 41412007 7144 PM

(9) Run the example by selecting Debug->Start Debugging. You should see a Microsoft
Internet Explorer window open that contains the button added. Press the button and the
method added in step (6) should be called, binding the FetchedData DataRows returned into
the GridView control.
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€ Untitled Page - Microsoft Internet Explorer provided by Com... g@

%} - |§, http: fflocalhost: IBEEIﬂM l@] &J Google (O[]
'i{? 'JI}: | @Untitled Pange [_| ﬁ h [3 o i
P
ORDERNUMEBER CUSTOMERNANMIE ORDERDATE IE'
1 Rob's Recordsx 6/1/2006 12:00:00 AM
2 Kivoshi's Lamp Co. 6/5/2006 12:00:00 AM
3 Paul's Boutique 7/2/2006 12:00:00 AM
4 (Olga's Dolma Company 7/6/2006 12:00-00 AM
5 Franks Franks Co. 7/9/2006 12:00:00 AM
4] Cheeky's FX Corp. 7/10/2007 12:00:00 AM
7 The Book Company  7/15/2006 12:00:00 AN
8 Donkey Custard Co.  7/25/2006 12:00:00 AM
0 1/1/0001 12:00:00 AM
0 1/1/0001 12:00:00 AM v

% J Local intranet Ho100% v
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Troubleshooting
1. Problem: You receive the following exception at runtime:

An unhandled exception of type 'System.Configuration.ConfigurationErrorsException' occurred in
System.Configuration.dll

Additional information: An error occurred creating the configuration section handler for
Dispatchers/Service_x0020_Dispatcher_x0020_Debug/Environments/Default/Default: Exception has been
thrown by the target of an invocation.

Solution: Make sure the following Plex runtime assemblies are located in the directory where
your .NET Forms application is running from. The highlighted Plex.Controls.dll files
may not be copied by default.

Marne
Cja-IP
%) Interop. PlexAPILib. di
,£| Ple:. Common. dll
-E Plex. Common. pdb

" Plex Controls,di |
ﬂ Plex, Controls, pdb
%] Pl ObRun. dil
-E] Plex . ObRun. pdb
Ewmdnws Client, exe
@Windaws Clignt, exe.canfig
-E Windows Client. pdb

EWindDws Client, vshost . exe

2. Problem: You receive the following exception at runtime:

An unhandled exception of type 'System.NullReferenceException' occurred in Windows Client.exe

Additional information: Object reference not set to an instance of an object.

Solution: The Windows Client.exe.config or Plex.ObRun.dll.config file your
.NET application is trying to load does not have the correct configuration information stored
within it. Copy the PlexRuntimeConsole.exe.config file into the directory where your
.NET Forms application is running from, or the current directory where you are debugging
your ASP.NET application from and rename it accordingly.

Notes

1. You do not need to have the Plex .NET Runtime Service running in order for these examples
to work. The Windows Forms application process contains the Plex .NET Runtime instance

being used.
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(5) Using Code Library Objects to Create .NET Assemblies

Introduction

For large-scale projects, generating C# source and compiling it into one assembly is less than
ideal. If one function changes, then the whole assembly effectively must be changed. Also the
size could be prohibitively large; making the application impossible to install and administer.

To solve this problem, Plex has introduced the concept of Code Libraries. These objects can be
modeled to contain a logical subset of an application; the subsets could be functional units of an
application, or could be functions that define a revision of an application.

The following document outlines the steps required in order to create multiple assemblies that
contain CA Plex generated C# functions.

(A) Modelling Code Libraries

First, you must create Code Library objects that define the subsets of the application that you
want to deploy. The top-level Code Library objects will ultimately get created as assemblies, so
the triples that you define against the Code Library reflect the attributes and manifest information
that will be created in each assembly.

A Code Library must contain one or more Package objects, which in turn, must contain one or
more Function objects. The following shows a typical structure for a Code Library, as seen in the
Plex Object Browser.

— Top-level (unscoped) Code Library called
= il Urder ‘Order’; this will be created as an assembly unit
=53 Code Library Contert of the application.
== Order
21> Package Content The Code Library contains one Package object,

. . in this case called ‘Order’ (although the name
= Order.Detail Bys uergate.Ne:-:tSurrn:-gate\ could be anything). Note that the Code Library
= Order. Detail Fetch BlockFetchS et object does not scope the Package — as such,
— . the Package object could be contained in
= Order.Detail Fetch. CheckRow multiple nge LJibraries.
= Order.Detail Fetch.SingleFetch
= Order.Detail Update. CheckedU pdate
= [rder.Detal Update. DeleteRow - - - -
— . The package contains multiple Function objects.
& Order.Detail Update InsertRow This association between Package and Function
= Order.Detail Update. UpdateR aw objects is the same as in previous releases; as
— such you can reuse any of the Package
= Order Header Fetch BlockFetch modeling you may already have in your models,
& Order Header Fetch.CheckRow if you so wish.
= OrderHeader Fetch. SingleFetch
= Order.Header Fetch StatelessBlockFetch
= Order.Header.Update. CheckedU pdate
= Order.Header. Update. DeleteR ow
= Order Header. Update. lnzertH o
= Order.Header Update. UpdateR ow
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Because Plex functions cannot be added directly to the Code Library object, they must first be
scoped to Package objects. This can be achieved by using the PKG contains FNC triple. The
following shows a Package called ‘Order’ that contains the server functions associated with the
Order.Header and Order.Detail entities.

The Package information for a function will define the .NET Namespace into which the classes
associated with that function will be generated.

Order ; containg Order.Detail BySurrogate. MestSurogate
. Order. Detail Fetch Block FetchS et
Order.Detail Fetch. CheckRow
Order. Detail Fetch. SingleFetch
Order.Detail Update. Checkedpdate
Order.Detail Update. DeleteR ow

Order Detail Update InsertFow
Order.Detail Update. L pdateR ow

Order Header Fetch BlockFetch

Order. Header Fetch CheckR ow

Order Header Fetch SingleFetch

Order Header Fetch StatelessBlockFetch
Order Header Update. Checkedlpdate
Order Header. Update. DeleteR aw

Order Header. Update. InzertF ow

Order Header.Update. UpdateR ow

This Package object is associated with the Code Library by using the CDL Comprises PKG
triple. By doing this, you can view the contents of the Code Library in the Plex Object Browser.

The following shows the triples for a Code Library called Order which is contained in the
SALESSYSTEM sample local model.

Order comprizes Order
Company name Ca,
copyright information | Copyright!nfarmation
Najor version 1
MAINOT WEersion 0

trademark. information| Trademarklnformation

product Praductinfarmation
MET type Azzembly

file: harne Order

impl name Order

build rumber 1

revision number 0

lahguage CH
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There are a number of descriptive label objects in the above list, such as ‘Company name’,
‘Copyright information’, ‘Trademark information’ and ‘Product’. These labels should have their
values coded into their literal values as follows:

Details for Label: Copyrightinformation

Mame ] Infolmationl Securit_l,l] Marative Literal

Walue:
Copyright Cé, 2006

k. | Cancel | | Help |

You have now modeled your Code Library and are in a position to generate the source used to
create it.

If you have followed the examples right from the start, you do not have to generate any C# code
in order to create your assemblies. In the first example, you generated your source code, and
then compiled it into the Plex .NET Default Assembly. The information in this generated code is
completely independent of any Code Library in which you place it. It is perfectly acceptable to
generate, build and test your application using the default assembly created from the generate
and build window, and then create your .NET assembly units at a later point in your development
cycle — all without having to regenerate a single line of code.

Note: Because Package information is generated into the source for a function in the form of
namespace information, you must make sure your any package modeling you wish to do is
completed before you generate your application source.

All information specific to the Code Library objects being created is generated and compiled into
the target assemblies by the new CA Plex Code Library Deployment Wizard.
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(B) Packaging and Deploying a Code Library
In order to create an Assembly from a Code Library, you need to use a new Plex tool called the
Plex Code Library Deployment Wizard.

Note 1: Because this tool uses the Plex COM API interface you must make sure that the PlexAPI
interface is registered on your target machine. This should be taken care of by the Plex install
process, but if you need to perform this step manually, please refer to the Troubleshooting
section at the end of this document.

Note 2: To launch the Wizard, select Code Library Wizard menu item from the Tools menu.

Starting the wizard should show the welcome screen, select ‘Next’ to start the packaging and

deployment process.

B Code Library Deplo

Help |

ment Wizard _ O] x|

Welcome to the Packaging and
Deployment Wizard!

This wizard will guide your through the process of creating the units of your Ca Plex CH
or Java application.

It waill guide you through the process of selecting Code Library objects modelled in your
application, and building thoze into MET Aszembly [.dll] or Jawa Archive [jar] files pou
can rn.

To continue, click Mext

[T Do not show this Welcome page again

< Bk Meut = Cancel

The next screen lists the unscoped Code Library objects that are present in your model, and are
have enough information to allow the creation of an Assembly.

Select the Code Library objects that you wish to deploy and select ‘Next'.
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& Code Library Deployment Wizard
Select Code Libraries

Select the Code Library objects that pou wigh to package and deploy.

[ arder
I;::] Support

HHElp | < Back Mext > LCancel

The next screen shows the options that the Wizard will use when creating the assemblies. These
options are defaulted from the Generate and Build options from the current local model, but can
be overridden if required.
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Code Library Deployment Wizard
Build Properties

Enter the build properties you wigh to uze in order bo create the Azzemblpdlar files.

e
o
E [1] General ~
Generate Emror Messages True
Include Default Packages Falze
PlexRuntimeDirectony C:%\Program Files\CA\Plex\6.1
Preview Output True b
Yerbogze Compiler Qutput Falze
B [2] CH
Additional References
Agzembly Sighing - Mo azzembly zighing will be uged -
Debug Falze
Default Package Mame SalezSystem
Source Directony C:\Documents and SettingsZAll UsershDocumentsiCA
Target Directom C:\Documents and SettingsVAll Usersh\DocumentsiC#
E (3] Javra
Additional References C:A\Documents and SettingsZAll Usersi\Documentsi\C2
Build Director C:ADocuments and SettinosZAll Users\DocumentsiCE ™

Preview Output
Prewview the contents of each Code Libram object created [zelecting thiz option takes some time ta run).

[ { Back ][ Heut » ][ LCancel

If you set the Preview Output option to True (the default is False), then the next screen allows you
to review the Code Libraries you have selected for deployment. You can drill down into the
libraries and see their packages and functions that will be contained within them.
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Code Library Deployment Wizard |Z||E|E|

Review Code Libranes

Feview the Code Library objectz you have selected to deploy.

i
oy
ol
g
>

Order Detail BySurogate. MestSurrogate
Order.Detail. Fetch.BlockFetchSet
Order.Detail Fetch. CheckRow

Order. Detail Fetch. SingleF etch
Order.Detail Update. CheckedUpdate
Order.Detail Update. DeleteRow

Order. Detail Update. InzertRow

Order Detail Update UpdateR aw

Order Header Fetch.BlockFetch

Order Header. Fetch.CheckRow

Order Header Fetch SingleFetch

Order Header Fetch.StatelessBlockFetch
Order. Header.Update. CheckedUpdate
Order Header lpdate.DeleteRow

Order Header. Update InsertRow =
Order Header.Update. UpdateR aw

CELELELEEELELLLELE T

[=)-+23 Suppart
=4 ¥ System
% SalezSurrogateSystemn.Fetch.CheckRow

{ Back ][ Heut » ][ LCancel

Selecting ‘Next’ opens the ‘Plugin Options’ screen that does not require any changes.

|£




@)

NET Support and Code Libraries
Sample Model

Code Library Deployment Wizard |’._||’E|E|
Plugin Options
Select any additional plugin that you wizh to wn duing deployment.
Flug-in: | v | Do not generate services.
=
{ Back ][ Heut » ] [ LCancel

Selecting ‘Next’ will start the assembly build process.

The next screen shows the output of the build process; you should see that your assemblies are
created without any errors or warnings.

You can only select ‘Next’ when the build has completed.
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Code Library Deployment Wizard [EE]

Code Library Creation

Compiling zource code into deployment objects.

=== Code Library Creation Started ===

—————— Build started: Code Library: Order ------

Created Code Library: C:hDocuments and SettingshAll UszersiDocumentshWCAWPlexhwé. 1Y SAMPLE
—————— Build started: Code Libkrary: Support —-—----

Created Code Library: C:hDocuments and Settingshall UsersiDocumentshWwCAWPlexhd. 1% SAMPLE
=== Code Library Creation Complete ===

< | _
{ Back ][ Heut » ][ LCancel ]

Congratulations - You should have successfully created an assembly that contains the required
Plex functions.

Select ‘Finish’ to close the Code Library Deployment Wizard.
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£8 Code Library Deployment Wizard [:”E

Code Library Targets Created

Congratulations! all Code Librany objects have been created.

Your compiled &zsemblies can be found in the C:hDocuments
and Settingshall

U zers\Documentz CaNPleshe. 18SAMPLES Dot MET
Support and Code LibrariestGEMBID directory.

To close thiz wizard, click Finish.

[ { Back ][ Einizh ][ LCancel

But what actually got created? And how do we use them?

The directory in which the Code Library Assemblies reside is based on the target directory that
specified in the build options (step 3 of the wizard). The actual directory will depend on whether
you selected Release or Debug as your build option.

These are named after the CDL File name NME property you specified when you modeled your
Code Library object.

0.l

E‘ Order.pdb

. Support.dil

E‘ Support.pdb
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You can see the contents of the assembly using the Il Dissasembler tool shipped with the .NET
Framework.

£ C:\Documents and Settings\tll Users\Docume. .. [ZI[E|E|

File Miew Help

F MANIFEST
= ' Swskem
E System, SurrogateCheckRow_ObFnc
E Syskem, SurrogateCheckRaw_ObIn
E System, SurrogateCheckRow_ObCuk
E System, SurrogateCheckedUpdate_ObFnc
E System, SurrogateCheckedUpdate_ObIn
E System, SurrogateCheckedUpdate_ObOuk
E System, SurrogatelnsertRow_ObFnc
E System, SurrogatelnsertRaw_ObIn
E System, SurrogatelnsertRow_ObCuk
E System, SurrogatehexkSurrogate_ObFnc
E System, Surrogatehexksurrogate_ObIn
E Sysbem, SurrogateMexkSorrogate_ObCuk
E System, SurrogatesSingleFetch_ObFnc
E Syskem, SurrogateSingleFetch_ObIn
E Syskem, SurrogateSingleFetch_Obout
E System, SurrogateUpdateRow_ObFnc
E System, SurrogateUpdateRow_ObIn
E System, SurrogatelpdateRow_Obouk

&8 & -8 -8 -8B BB - BB B BB - E

< >
.assembly Suppart

~er 1010

In order to use the assemblies with the Plex runtime, you need to specify the names of the
assemblies in the AssemblyList entry in the configuration file for the .NET Runtime you are
using.

Multiple entries can be made in this field, and at runtime, it is searched in a similar manner to a
PATH variable or a Java Class Path. Also, in a similar manner to the PATH and Java Class Path
entries, multiple entries are separated by semicolons.
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B General
Azsemblylizt T Support and Code Lihlaries\Een"uBId"l.Suppnrt.dII;E:"'.Prm.;l
Culture en-US

B Preferences
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Troubleshooting

(1) Problem: You receive the following error when launching the Code Library Deployment
Wizard:

-,

DeployToolll

Eﬁ IJnhandled exception has ocoured in vour application. |f you click,

Continue, the application will ignore this emrar and attempt ta continue. If
youl click Quit, the application will cloze immediatel.

IInable to cazt COM object of type 'Plex4PILib PlextPIClass' to interface
twpe 'PlexdPlLib I PlessPl. This operation failed because the
Lluemlnterface call on the COM component faor the interface with [1D
HABS40011-9042-1104-4844-0008C73C4834) falled due ta the
following error: Error loading tvpe library/DLL. [Exception from HRESLULT:
OxB0029C44 [TYPE_E_CANTLOADLIBRARYT).

*  Details [ Continue ] [ Guit ]

Solution: Register the PlexAPI COM interface. To do this, go to a command line, change
into your Plex installation directory and enter the following command:

Plex.exe /RegServer
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